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Chapter 1: Introduction

This document describes the new and changed features in EuControl software version 19.7 for Avid S3, Dock, Control app, and 
Artist Series media controllers for Avid Pro Tools® and other EUCON™-aware applications. 

• For complete descriptions of features, see New and Changed Features in EUCON 19.7. 
• For additional information about fixed and known issues, see EUCON v19.7 Release Notes. 

System Requirements and Compatibility
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For the latest infor-
mation about operating system requirements, compatible DAWs and other applications, and links to additional resources, visit 
EuControl Compatibility. 

DAW Compatibility At the time of this writing, EuControl Software v19.7 is compatible with the following (or later versions): 
• Avid Pro Tools and Pro Tools | Ultimate 2019.5 or later (2019.6 is required for some included fixes)

• Steinberg Nuendo 7 and Cubase 8 and later
• Apple Logic 10 
• Magix Sequoia 14
• Merging Pyramix 8.x Native only, and Pyramix 9.x and later
• Avid XMON S6
• Pro Tools | MTRX, and ProMon (DADman) for Pro Tools | MTRX and NTP Technology AX32

For setup and configuration instructions for several applications from EUCON Development Partners, see the 
EUCON Application Setup Guide.pdf, available for download from your Avid account. Please note that while these applications 
are EUCON-enabled, the extent of integration with Avid control surfaces and supported software versions are at the sole direction 
of the respective manufacturer. For details, please contact the manufacturer. 

On macOS 10.14/”Mojave” (only) you will be prompted to add applications such as EuControl and Pro Tools to the Privacy list in 
System Preferences. If so, follow the on-screen instructions. 

Important!

The EUCON performance improvements introduced in v3.5 make it and all later versions (including v19.7) incompatible with 
v3.4.x and previous versions of EUCON and EuControl. As a result, the current and future versions must not be run on the same 
network (subnet) as any 3.4.x or previous EUCON Surface software. 

• To get the latest version of EuControl software for S3, Dock, and Artist Series, download it from your Avid Account. 
If you are registering an Artist Series unit and have its serial number, you can also visit:

http://www.avid.com/en/products/artist-control/learn-and-support

Because of the major changes in EuControl 19.5 for attention and plug-in window workflows, there may be undesirable behavior 
with earlier versions of Pro Tools. If using Pro Tools 2018.12 or earlier, consider disabling the attention and plug-in window set-
tings introduced in S6 and EuControl software 19.5. 
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Software Installation
To install EuControl software, follow the instructions in the most recent editions (19.5) of the following guides: 

• Pro Tools Control Guide.pdf

• Pro Tools Dock Guide.pdf

• Pro Tools S3 Guide.pdf

About This Guide
All of our guides use the following conventions to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The names of switches and keys on the control surface are shown in bold (such as Select). In addition, the Shift switch on the 
Master, Fader, or Joystick Module is always shown in bold to distinguish it from the Shift switch on the computer keyboard. 

The following symbols are used to highlight important information:

How to Use this PDF Guide
These are some useful features of this PDF:

• The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page.
• Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading.

• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns 
into a finger, then click to locate to that subject and page.

• All cross references in blue are active links. Click to follow the reference.

• Select Find from the Edit menu to search for a subject.

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.
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Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. 
The following are just a few of the services and features available. 

Account Activation, Product Registration, and License Activation
Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your 
purchase online, download software, updates, documentation, and other resources. Activate your software license

https://www.avid.com/account

Get Started Fast Video Tutorials
Watch video tutorials for the Control app, Dock, S3, and other EuControl products on YouTube:

Get Started Fast with Pro Tools | Control, S3, and Dock

For S6, check out the new Avid Pro Tools | S6 Workflows and original Get Started Fast with S6 video tutorials, available on 
YouTube. 

You can find more videos, including the latest workflow tutorials, on the Avid website. Go to www.avid.com, view Products and 
select Pro Mixing. Follow the links for your controller and check the Learn and Support listings for video resources. 

Support and Downloads
Contact Avid Customer Care (technical support); download software updates and the latest online manuals; browse the Compati-
bility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on the 
User Conference. For example, for Pro Tools | Control resources visit: 

https://www.avid.com/learn-and-support

For user guides for Pro Tools | Control, S3, Dock, and Artist Series media controllers, visit: 
EuControl Product Guides
For setup and configuration instructions for several applications from EUCON Development Partners, see the 
EUCON Application Setup Guide.pdf, available for download from your Avid account. 

For S6 support, trouble-shooting, and downloads, visit: 
http://avid.force.com/pkb/articles/faq/Avid-S6-Support

Products and Developers
Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and 
hardware. 

https://www.avid.com/Products/index.html

News and Events
Get the latest news from Avid or sign up for an S6 demo. 
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Chapter 2: New and Changed Features in EUCON 19.7

EuControl Software v19.7 provides the following new and changed features. 
• Further Improved “Open Windows on Workstation Attention” Setting

Further Improved “Open Windows on Workstation Attention” Setting
To improve window behavior, the Open Windows on Workstation Attention setting has been expanded. 

In previous versions of EuControl this setting (located in the General tab of EuControl Settings) was a simple on/off control: 
• When this setting was enabled, plug-in, pan, or send windows in your DAW opened when a track was attentioned according 

to the current Attention Most Recently Clicked DAW Area settings.
• When this setting was not enabled (the default setting), windows only opened in the DAW when you explicitly attentioned a 

track from your control surface. 

Beginning in EuControl 19.7 this setting now lets you specify which surface triggers Open Windows in Pro Tools from an attention 
that comes from the DAW.

Choices include the following:

This setting was first introduced in S6 software version 19.5. Beginning in v19.5.1, both EuControl and S6 provided this setting. 

Open Windows on Workstation When Knobs Assigned From DAW Click

Setting Description

Off

Pro Tools | Control Selecting a function in the Control app opens or changes the DAW window

S3 Upper Knobs Selecting a function on the upper row of S3 knobs opens or changes the DAW window

Channel Mode Knobs Selecting a function on the Channel knobs (lower knobs on S3, channel knobs on Mix) open or change the 
DAW window

General tab of EuControl Settings
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Additional New and Improved Features
The following features were provided in EuControl 19.5.1. 

Improved Momentary Fader Value Display
Display of track name and values can be configured using the Show Timed Fader Values and Fader Value Timeout settings. In 
EUCON 19.5.1 these settings have been improved to provide more options to optimize name/value display. These settings are lo-
cated in the Preferences tab of EuControl Settings. 

To improve Momentary Fader Value display, the following new options have been added: 

Momentary Fader Value settings in EuControl Settings > Preferences

Settings for Momentary Fader Value

Setting Description

Off Displays always show track name (ignore Fader Value Timeout)

While Fader is Touched Shows value when fader is touched and reverts to track name when released

Timed at Fader Touch, 
Off at Release

Shows value on touch, reverts to track name when the timer expires
• If the fader is released before the timer expires, the display reverts to name 
• If the Fader Value Timer slider is set to Off (full left), then values are not shown

Timed at Fader Touch

Shows value on touch, reverts to track name when the timer expires 
• If the fader is released before the Fader Value Timer setting expires, the display stays on value until the 

timer expires then reverts to name
• If the Fader Value Timer slider is set to Off (full left), then values are not shown

Timed at Fader Release
(default)

Shows the value while touched and continues to show value on release until the timer expires
• If the timer is set to OFF, shows value when fader is touched and reverts to track name when released 

(equivalent to ‘While Fader is Touched” option)
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Chapter 3: EUCON v19.7 Release Notes

for S6, S3, Dock, Pro Tools | Control, and Artist Series Control Surfaces

This document describes the fixed and known issues in EUCON 19.7 for Avid S3, Dock, Pro Tools | Control, and Artist Series 
control surfaces. 

What’s Fixed in EUCON 19.7
• Windows that open from a surface attention would not always follow the surface's selected function (GWSW-12607)

• Pro Tools | Control: The Tracks view could take longer to populate than in previous versions (GWSW-12665)

• Dock: Knobs would lose focus when the Control app was navigated away from Channel view (GWSW-12619)

• On-screen controls in XMON software could appear to not respond to surface controls (GWSW-12512)

• S3/Dock: On Windows 10, custom surface names could fail to be shown (GWSW-12542)

• The value for Fader Timeout Value would not update until the slider was released (GWSW-12670)

• EuControl software now displays correctly in macOS “Mojave” Dark mode (GWSW-12190)

• S3 faders could move when banking with Nuendo (GWSW-11745) 

• S3 faders could cause unexpected changes to values in Cubase (GWSW-11553)

What Was Fixed in EUCON 19.5.1
• EuControl: Soft Keys for Pro Tools could fail to import into v19.5 (GWSW-12432)

• On macOS Mojave, text such as application names could appear upside down (GWSW-12442)

• Pro Tools | Control could fail to accurately indicate workstation connection status when focused on a non-EUCON application 
(GWSW-12441)

• Layouts could fail to be saved as expected (GWSW-12455)

• It was possible for windows to open and close (or not) in an undesirable fashion when using the Attention and Open Window set-
tings added in v19.5. See Further Improved “Open Windows on Workstation Attention” Setting. 

• S3 and Mix: OLEDs could fail to update (GWSW-12431)

• S3: Plug-in and Send windows could fail to close after navigating back to the top level Inserts or Sends view (GWSW-12456)
Requires Pro Tools 2019.6

• Adding or deleting tracks in Cubase or Nuendo could appear to freeze and blank out surfaces (GWSW-12466)

• MackieControl could fail to load if auto-started by EUCON Preferences on macOS (GWSW-12443)

• An appset has been added for Calendar on macOS

Documentation
• The following description of the Close Windows on Workstation When Exiting setting appeared in the 19.5 editions of the 

What's New in EuControl 19.5.pdf, Pro Tools Control Guide.pdf, Pro Tools Dock Guide.pdf, and Pro Tools S3 Guide.pdf: 
Close Windows on Workstation When Exiting
When this setting is enabled, attentioning any other track “exits” the current function and closes the corresponding window 
type(s) selected in Open Windows on Workstation When Editing (unless the same function exists on the newly attentioned track, 
in which case the window remains open but is focused on the newly attentioned track).
Correction: In EUCON software 19.5, opened windows would in fact not follow if the same function existed on the newly 
attentioned track. This behavior has been fixed in EUCON software 19.5.1 (windows now do follow attention, as previously 
documented). 
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What Was Fixed in EuControl 19.5.0

All EuControl Devices / EuControl Software
• EuControl: After assigning an Attention/Selected Track in a Layout it was possible for that track to not appear when recalling 

the Layout until viewing, leaving, and then returning to the Assign tab (GWSW-11591)

Pro Tools | Control, S3, Dock, Artist Series
• Spilling a VCA over a currently spilled VCA could clear track assignments (GWSW-11562)

• It was possible for the Control app Main Counter to not display properly when connected to Digital Performer (GWSW-11228)

• In the Control app, meter peaks could fail to clear when Peak Hold is set to “3 seconds” (GWSW-11284)

• Meters in the Control app could become intermittent (GWSW-11910)

• It was possible for send values displayed in the Control app to not match S3 or other surfaces (GWSW-11587)

• When a Dock and Artist Mix were attached it was not possible to collapse a VCA spill from the Dock (GWSW-11520)

• It was possible for Dock and Artist Series units to become unresponsive in certain power-up sequences (GWSW-11282)

• S3 with Dock: The Pro Tools Mix or Edit windows could auto-scroll after selecting an off-bank track (GWSW-11618)

• Spilling a VCA or using Bank to Selected Track could move tracks to the left by one strip (GWSW-11534)

• When assigned to a EUCON Master in Pro Tools, pressing the Dock Monitor knob with Option key could incorrectly light the 
Cut LED (GWSW-11702)

• It was possible for knob displays to be blank after auto-inserting a default EQ or Dyn plug-in (GWSW-11539)

• An erroneous “Versions are incompatible” message could appear when adding the Control app to My Surfaces (GWSW-12086)

• It was possible for MackieControl to not function correctly with newly installed versions of EuControl (GWSW-12213)

• When using the Dock with Apple’s Logic Pro X it was possible for the Jog and Shuttle switch LEDs to incorrectly indicate status 
(GWSW-12303)

What Was Fixed in EuControl 18.3.0
(For S6, see the What’s New in S6 18.3.pdf.)

All EuControl Devices / EuControl Software
• At times, the Rec switch automation LED would insist on illuminating while in Read+Trim mode (GWSW-11029)

• The Record Ready LED could remain off while recording in Pro Tools if the Preference Rec/Auto switch press changes au-
tomation modes was not enabled (GWSW-11045)

• The Rec switch automation LEDs could flicker when writing automation if the Preference Rec/Auto switch press changes au-
tomation modes was enabled (GWSW-11224)

• S3 or Artist Mix: Pressing a knob while Flip mode was active would reset the fader instead of the control assigned to the knob 
(GWSW-11257)

• When in Flip mode while the EuControl Preference setting SHIFT + fader sets level to 0db enabled, resetting the fader value 
by holding SHIFT and touching the fader would not set it to the correct default and adjust pan (GWSW-10835)

• Network settings in EuControl Preferences and WSControl could end up out of sync after a clean install (GWSW-11526)

• The External Workstation setting in EUCON Preference could become unavailable (GWSW-11242) 

Pro Tools | Control
• It was possible for the Track name displayed in the lower left corner of the Control app to not update correctly after spilling a 

VCA (GWSW-11028)

• It was possible for the Auto Spill VCA from Control App Attention setting to require toggling before it worked (GWSW-11286)

• The Main Counter would not always update when switching between applications (GWSW-11229)

• Pro Tools | Dock

• The Rec/A switch LED now correctly flashes to indicate when you are writing automation (GWSW-11025)

• Knobs on the Dock needed an acceleration curve for better control of parameters (GWS-11314)
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Pro Tools | S3
• When recalling Layouts from Layout switches A–E, switch LEDs would not always light when active/selected (GWSW-11033)

• When in Flip mode with Pan assigned to a fader, Opt/Alt+touching the fader would set Pan value to 0, as expected, but the fader 
would not move to the correct position (PT-238654)

• When viewing Pan in Channel Control, switch assignments could be incorrectly mapped (GWSW-11313)

Artist Series
• When spilling a VCA from the Control app, the VCA Master would sometimes appear on Artist Mix regardless of the S3/Dock 

VCA Master setting (GWSW-11027)

• Artist Transport: It was possible for Shuttle to not work with the Shuttle ring (GWSW-11327)

Known Issues
The following issues are not addressed in EuControl 19.7. Where applicable, a workaround is provided. 

(For S6, see the What’s New in S6 v19.7.pdf.) 

General Issues
• Microsoft Windows 10 Creators Update

If your system is running Microsoft Windows 10 Creators Update do not enable the Enable External Workstations in EuControl 
to avoid problems with mouse clicks. 

• Wi-Fi crashes EuControl when trying to play back a Pro Tools session from a second workstation (EUCON-3945)

If you have chosen Wi-Fi in EUCON Preferences, you may experience this issue as using Wi-Fi to connect two Workstations is 
not supported. Instead, make sure you connect Workstations via Ethernet cables and choose the corresponding Network Inter-
face in EUCON Preferences on both Workstations.

• EuControl will crash after switching Wi-Fi on workstation and iPad from one network to another (EUCON-4015)

• On-screen (DAW) indication of focused tracks gets out of sync when adding or removing surfaces or the app (EUCON-4021)

Pro Tools | Dock
• Preference for Dock Automation Buttons Follow Attentioned Channel is only supported in Pro Tools (EUCON-4706)

At the time of this writing, the Dock automation buttons follow attentioned channel setting is fully supported only with 
Pro Tools. In addition, with Logic Pro, Dock Automation LEDs only light when this setting is enabled. If it is not enabled, no 
Automation switch LEDs light. Also Logic Pro does not yet display the correct Automation LED for Touch and Touch/Latch. 
With Nuendo, Dock Automation LEDs only light when this setting is enabled. If it is not enabled, no Automation switch LEDs 
light, and Nuendo will only indicate Read and Off modes, but not Write.

Pro Tools | Control
• Loss of Wi-Fi connection not always indicated in Pro Tools | Control (EUCON-4736)

If Wi-Fi connection is lost temporarily, it is possible for the Control app to appear as if it is still connected and still appear in My 
Surfaces. 

Workaround: Restart EUCON Applications after Wi-Fi is re-established. Or, enable the “Forget Network” setting on your iPad. 

• Pro Tools | Control App: Visual artifacts after entering non-English text into text field and hiding the keyboard (EUCON-4058)
Workaround: Quit the app, switch keyboard to US English, then relaunch the app. 

Pro Tools | S3
• Connecting an S3 Network port to a network switch with BPDU (Bridge Protocol Data Unit) guard enabled can disable the port 

on the switch the S3 is connected to (VSW-10570)

Do not connect S3 to any network switches that have BPDU guard enabled. If an S3 is to be connected to a network such as a 
corporate network, make sure BPDU is disabled on all switches present in the network.

• S3: Functions assigned to the lower knobs can adversely effect Open/Close window functionality (GWSW-12399)
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• (S3 Only) When using Logic, channel strip meters may flicker and disappear if the signal on the corresponding track is clipping 
(EUCON-3285)

Workaround: Attenuate faders until meter LEDs reappear.

• (S3 on Windows Only) Using Application/Workstation + < Bank to cycle through open applications does not work 
(EUCON-3105)

Workaround: Only cycle through applications to the right using Application/Workstation + Bank >.
• (S3 Only) When using S3 with Nuendo 6, the Channel Control Navigation In switch does not toggle EQ parameters on/off 

(EUCON-2743)

Workaround: Toggle the EQ on/off on-screen.

• Disconnecting the Ethernet cable from the Dock or an Artist Series device can cause the device to freeze (EUCON-2844)

To reestablish communication:

1 Disconnect the power cable to the surface to power it down. 

2 Power down your workstation computer.

3 Reconnect power to the surface and then power the surface back on.

4 Power the workstation computer back on.

• If a custom appset was created using Pro Tools 11.3 or lower, labels for S3 soft keys in the EuControl Settings > Soft Key tab 
may be incorrect (EUCON-3574)

Workaround: In the EuControl Settings > Soft Key tab, click the Restore button to load the factory default Soft Key appset for 
the current version of Pro Tools. 

• (Pro Tools 12 and higher only) If an Artist Mix and an Artist Control are connected to Pro Tools, when the Mix and/or Edit Win-
dow Follows Surface Bank preference is enabled, only banking on Artist Mix is followed in Pro Tools (EUCON-3599)

• Surface meters do not work with audio tracks in Media Composer 8 (EUCON-3144)

• In certain cases after inserting a default EQ/Dyn plug-in, attentioning the track with the plug-in inserted may not automatically 
open the plug-in window in Pro Tools (EUCON-2877)

Workaround: Depending on the type of plug-in inserted, press EQ or Dyn on the surface to open the plug-in window on-screen.

Updating Firmware on EuControl Surfaces
To update firmware:

1 After updating EuControl software, click (Mac) or double-click (Windows) the EuControl icon and select EuControl Settings.

2 If necessary, click Surfaces to display the Surfaces tab.

3 Click a surface in the My Surfaces list so it is highlighted. If multiple surfaces are listed in the My Surfaces list, make sure only 
one surface is highlighted. 

4 Click Update Firmware.

5 Follow the instructions in the Update Firmware dialog box to proceed, and make sure to observe the following guidelines when 
updating firmware:
• Ensure that all surfaces are connected to a trustworthy power source.
• Do not power off the surface during the update or attempt to interrupt the update.
• The status of the firmware update is shown in the EuControl dialog, and on the surface displays.

6 Click Done when the firmware update is complete. Repeat this procedure for each surface in your system.

Firmware must be updated on each surface separately. Updating firmware on multiple devices at the same time is not supported.
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Technical Support (USA)
Visit the Online Support Center 
at www.avid.com/support
Product Information
For company and product informa-
tion, visit us on the web at www.av-
id.com
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